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Important Notice 
 
Texas Instruments Incorporated and/or its subsidiaries (TI) reserve the right to make corrections, 
modifications, enhancements, improvements, and other changes to its products, software and ser-
vices at any time and to discontinue any product, software or service without notice. Customers should 
obtain the latest relevant information during product design and before placing orders and should ver-
ify that such information is current and complete. 
 
All products are sold subject to TI’s terms and conditions of sale supplied at the time of order ac-
knowledgment. TI warrants performance of its hardware products to the specifications applicable at 
the time of sale in accordance with TI’s standard warranty. Testing and other quality control tech-
niques are used to the extent TI deems necessary to support this warranty. Except where mandated 
by government requirements, testing of all parameters of each product is not necessarily performed. 
 
TI assumes no liability for applications assistance or customer product design. Customers are respon-
sible for their products and applications using TI products, software and/or services. To minimize the 
risks associated with customer products and applications, customers should provide adequate design, 
testing and operating safeguards. 
 
Any access to and/or use of TI software described in this document is subject to Customers entering 
into formal license agreements and payment of associated license fees. TI software may solely be 
used and/or copied subject to and strictly in accordance with all the terms of such license agreements. 
 
Customer acknowledges and agrees that TI products and/or software may be based on or implement 
industry recognized standards and that certain third parties may claim intellectual property rights 
therein. The supply of products and/or the licensing of software does not convey a license from TI to 
any third party intellectual property rights and TI expressly disclaims liability for infringement of third 
party intellectual property rights. 
 
TI does not warrant or represent that any license, either express or implied, is granted under any TI 
patent right, copyright, mask work right, or other TI intellectual property right relating to any combina-
tion, machine, or process in which TI products, software or services are used. 
 
Information published by TI regarding third–party products, software or services does not constitute a 
license from TI to use such products, software or services or a warranty, endorsement thereof or 
statement regarding their availability. Use of such information, products, software or services may 
require a license from a third party under the patents or other intellectual property of the third party, or 
a license from TI under the patents or other intellectual property of TI. 
 
No part of this document may be reproduced or transmitted in any form or by any means, electroni-
cally or mechanically, including photocopying and recording, for any purpose without the express writ-
ten permission of TI. 
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0 Document Control 

0.1 Change History 

 

Date Changed by Approved by Version Status Notes 

2001-Jan-31 JG et al.  0.1  1 

2002-Sep-30 RK  0.2  2 

2003-May-21 XINTEGRA  0.3 Draft  

2003-08-15 RK  0.4 Draft 3 

2003-09-15 RK  0.5 Draft 2 

 

Notes: 

1. Initial version 

2. updated 

3. Official ID introduced 

0.2 List of Figures and Tables 

0.3 List of References 

[TCC] 8415.028.99.201; March 15, 2000; Test Case Control – User guide 

[PCO2] 8415.090.00.002, May 15, 2000, PCO2 – Tracing Environment 
(pco_userguide.doc) 

[TC_INTRO] Running test cases with TAPCaller (tapcaller_intro.ppt) 

[TC_DESCR] 06-03-31-SLL, Tapcaller Developers Description (tap-
caller_description.doc) 

 

0.4 Abbreviations 

PCO Point of Control and Observation 

PS Protocol stack 

TAP Test Application Process 

TST TeST interface 

0.5 Terms 

Entity Program which executes the functions of a layer 
Message A message is a data unit which is transferred between the entities of the 

same layer (peer-to-peer) of the mobile and infrastructure side. Message 
is used as a synonym to protocol data unit (PDU). A message may con-
tain several information elements. 

Preamble Test case which is started before the actual test case.  
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Primitive A primitive is a data unit which is transferred between layers on one 
component (mobile station or infrastructure). The primitive has an opera-
tion code which identifies the primitive and its parameters. 

Service Access Point A Service Access Point is a data interface between two layers on one compo-
nent (mobile station or infrastructure). 
 
 



GSM Protocol Stack G23 TCAL-TapCaller User Guide (06-03-31-UDO-005) Draft 

 

Texas Instruments Proprietary Information – Internal Data Page 6 of 15 

 

1 Introduction 

Test cases and suites are used in order to test the implementation of protocol stacks. The Test Appli-
cation Process (TAP) is the real test tool. The actions performed by TAP can be described in simple 
words as follows: It sends primitives to an entity of the PS, waits for an reaction of the PS (i.e. waits for 
a primitve from the entity under test) and compares the received primitive with the expected one.  
TAPCaller is graphical frontend for executing test cases. It should simplify the call of the TAP test tool. 
Besides, the user can easily access result files which were produced by the TAP and PCO (the log-
ging tool) and it is possible to call MSCVIEW.  
This documentation is meant for protocol stack testers that use TAPCaller.  
 

2 Application Manual 

2.1 Quick start 

Before you can start the TAP using TAPCaller some configuration is necessary. Using the menu op-
tion "<Configuration><Settings>" the dialog box "Settings" is displayed. There the user has to specify 
the location of the appropriate TAP executable and the interface which stimulates the protocol stack 
(see document [TCC] for detailed information about the interface).  
Additionally on the sheets "Test tools" and "General options" some viewer applications can be se-
lected. 
 
Then, of course, the user has to specify the test cases and the path of the protocol stack to be tested. 
The menu option "<Configuration><Selection>" shows a dialog box that can be used for this purpose.  
 
If TAPCaller is started from an environment, where certain environment variables are set, most of the 
configuration is done automatically by the program. See 2.5 for more detailed explanations of the dia-
log boxes. 
 
If using the old TAP (with old FRAME) the tap-executable has to be build with the appropriate CDG-
files (created by makcdg). Logging while tests will be done by the TAP itself. 
If using the new TAP (tap2.exe) the tap will expect a matching ccddata_dll.dll (created by makcdg). 
Logging while tests will be done by PCO, which can be disabled in "<Configura-
tion><Settings><PCO>". 
 
Finally the TAP can be started by e.g. clicking the menu options "<Control><Run Selected tests>" or 
"<Control><Run All Tests>". 
 
See [TC_INTRO] for a short introduction with screen shots. 

2.2 Command Line Options 

When starting TAPCaller via command line you may optionally specify one of the following options: 
 

• -pco … automatically start PCO components 

• -nopco … do not automatically start PCO components 

• -impcfg <xml-config-file> … initially import configuration from specified xml-file 

• <.tcc-file> … load configuration from specified TapCallerConfig-file 

• -h … display all possible options 
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2.3 The Main Window 

 
 

After the execution of some test cases the TAPCaller Main Window may look like this:  
The first column contains the test case / suite name. The name of a test case consists of the name of 
the test document which the test case is produced from (e.g. "MCOMP"), three or four digits and op-
tionally a letter. The name of a suite (e.g. "mcomp.SUI_SYS_INFO4") starts with the name of the test 
document ("MCOMP") followed by a dot and the actual suite name ("SUI_SYS_INFO4"). The test 
document name have to be included since suite names are not unique among the various test docu-
ments.  
The following column shows the current state of the test case. In the given example the test case 
"MCOMP060C" is currently running, "MCOMP000" and "MCOMP009" have passed the TAP success-
fully, "MCOMP040C" has failed. If the test failed due to the failure of a preamble of this test case this 
preamble is added to the state (e.g. "MCOMP620" is failed because of "MCOMP020D").  
The third column contains the time of the last execution of the test case. There is no entry for test 
cases, which have not been run yet. 
Optionally the user can load titles from the according TDS-file (there exists a *.tds file for each test 
case) or directly from the TDC-Test-DLL. The titles can be seen in the last column of the main window 
(see chapter 0  
Settings – More Viewing Tools for the needed configuration in this context). 
 

2.3.1 The Tool Bar 

   (1)   (2)    (3)     (4)   (5)  (6)  (7)    (8)    (9)  (10)   (11) (12)(13) (14) (15)   (16) 
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The first two buttons of the tool bar are standard Windows buttons. They can be used to open an ex-
isting configuration (with binary settings and the selection of the test cases) produced by TAPCaller 
during former test sessions (1) – or to save the current configuration (2). 
Button (3) can be used to reset the whole test environment, if you think one of the tools got stuck. 
Clicking the following button (4) results in the execution of all selected test cases, (5) runs all test-
cases and (6) deletes the results of all test cases. With the next button (7) the user can stop the exe-
cution of test cases (the currently running test will most likely not be finished!). 
 
To view the content of the PCO logfile for the currently selected test case you may use button (8). 
 
Button (9) can be used to quickly enable/disable the automatic start of the configured protocol stack -
see also 2.5.2 where the Selection-Dialog is described, which can also be activated via button (10). 
The buttons (11)-(13) may be used to select/deselect all passed, failed or unknown/untested cases. 
 
If the T-button (14) is clicked the titles of the test cases are (re-)loaded from the according test defini-
tion script (*.tds) or directly from the TDC-Test-DLL.  
By using the R-button (15) test results can be reloaded according to the current test-directory content. 
 
The last button (16) displays copyright information. 

2.3.2 Context Menu 

When clicking with right mouse button at a 
test case a context menu appears. For each 
test case it contains the items "Delete" 
which removes the test results, "Execute" 
and "View MSC Flow" (enabled if a MSC 
Viewer is specified).  
If there are already log files for the currently 
selected test case the result (PCO logfile) 
can be viewed in a PCOViewer with the 
standard viewer configuration by selecting 
“View PCO logfile”. Moreover all other found 
PCOViewer configurations are added to a 
sub menu. When clicking at one of the latter a PCOViewer is started and the appropriate log file 
loaded so that the user can look at the results of the test session in a specially filtered way. 
Another sub menu contains the available dbg-files. 
The file TEST_TAP.PRT contains information the tap wrote while running.  
 
Double clicking on an entry will have the same effect as selecting “View PCO logfile”. If no results are 
available the execution of the dedicated test case is started instead. 

2.4 The Menus 

Some accelerator keys are defined within TAPCaller. They are displayed in the corresponding menus 
behind the items. 

2.4.1 The File Menu 

This menu can be used instead of 
the first two buttons in the tool bar.  
 
The second section contains entries 
for printing the current content of the 
TAPCaller window or export a proto-
col (see 2.5.3). 
 
Additionally there are menu entries 
for the last saved configuration files. 
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This option is useful for loading configuration files quickly. 
Configuration files will per default get the suffix “.tcc” (Tap Caller Configuration). Tapcaller will try to 
reload the lately used configuration on start up automatically. You may also specify a dedicated .tcc-
file as parameter to tapcaller.exe. 

2.4.2 The Control Menu 

In the Control Menu there are items for executing test 
cases (e.g. "Run selected tests" and "Run All Test" which 
means execution of all test cases in the main window) and 
stopping the execution after the termination of the currently 
running test case ("Stop Testing"). 
 
The entries in the second section can be used to delete 
test results. 
The third section contains items for selecting test cases 
from the main window ("Select all tests" …), 
 
The last entry resets the whole test environment. Use it if 
you think one of the tools got stuck. 
 
 
 
 
 

2.4.3 The View Menu 

This menu contains commands for changing the current visual state 
of Tapcaller as well as for viewing more details of the currently se-
lected testcase. 
 
“View Message Flow” will start the MSC-Viewer (selectable in the 
settings dialog, see 0) and pass the current test case to it – either via 
the corresponding test definition script (*.tds) or by using the new tap 
with parameter ‘-n’.   
“View PCO logfile” will open the logfile created during the last test 
execution in a PCO-Standard-Viewer using the configuration (.svc-
file) set as default (also selectable in the settings dialog, see 2.5.1.2). 
 

“Load Titles” tries to load the titles of the test cases in the main window and “Retrieve Test Results” 
reloads all test results according to the current test-directory content. 
 
The two last commands can be used to show/hide the corresponding toolbars. 

2.4.4 The Configuration Menu  

This menu is important since most of its members are not 
in the Tool Bar and the user needs them to run TAP.  
The menu item "Selection" is meant for calling the "Selec-
tion" dialog (see chapter 2.5.2 The Dialog Box "Selec-
tion"). There the user can search for test case dlls, test 
document dlls (test document dlls contain all test cases of 
a test document, test document dlls are produced with the 

batch file mkallin1.bat located in "<view>\Gpf\Bin") and suites. Furthermore the protocol stack which 
shall be tested can be selected there. 
The entry "Settings" calls the dialog box "Settings" with its sheets "General options", "PCO" and "More 
Viewing Tools" (see chapter 2.5.1 The Dialog Box "Settings" for further information).  Use “Load De-
fault Config” to load standard settings for a specific drive (usually where your CC-view is mounted). 
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2.4.5 The Help Menu 

The online help which can be requested via "TAPCaller Help" and “Help 
Topics” is very rudimentary and not up to date at the moment. This is a 
task for the near future.  
“Userguide” will open this file, which is updated more regulary. By selecting 
“Introduction” a short PowerPoint presentation is started, which will intro-
duce the main features of TAPCaller. 
Finally copyright and version information can be obtained via "About TAP-
Caller".  
 

2.5 The Dialog Boxes 

2.5.1 The Dialog Box "Settings" 

This dialog box is divided into three sheets: "General Options", "PCO" and "More Viewing Tools".  

2.5.1.1 Settings – General Options 

The snapshot on the left shows the "Gen-
eral Options" sheet.  
Before you can start the TAP you have to 
enter the location of the TAP executable.  
 
Below this path you may specify more 
options for the test session, like the num-
ber of repeats for each test case, the 
timeout the tap should apply before giving 
up waiting for incoming primitives and 
other options which will be passed di-
rectly “as is” to the tap. 
Moreover it is possible to explicitly specify 
the path to the CCDData-DLL which shall 
be used.  
 
In this section the user is able to specify 
the interface used for communication with 
the PS (see document [TCC] for detailed 
information about the interface) for a 
proper execution of TAP. Depending on 
the kind of interface the user can specify 
different parameters, e.g. the comport 
number for a USART interface or the 
name of the host for a socket interface. 
He can also specify whether PCON shall 
be used. For convenience the drop-down 
list on top contains several predefined 
configuration sets. 
 
The bottom part of the dialog contains 
some more (self explaining) general op-

tions. Running TAP in background is advantageous if there are many test cases to be executed. In 
this case it is possible for the user to continue his/her work with no windows turning up and immedi-
ately disappearing as it is the normal way of TAP execution.  
By selecting the old-FRAME-option you also have to specify a new tap-executable – the one you have 
build (e.g. tap2_gprs.exe). 
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2.5.1.2 Settings – PCO 

 
This sheet is used to configure the PCO.  

You may at first specify whether PCO shall be 
used for logging. (if using the old-FRAME-TAP 
PCO options are irrelevant) 
The first edit box shows the directory of PCO 
executables. This directory should be equal to 
the directory of the TAP executable for proper 
communication between the two processes. 
Therefore TAPCaller assists the user: When-
ever he or she wants to change the TAP direc-
tory he or she is asked whether the directory 
for PCO executables should be changed, too 
(it is recommended to click always "Yes").  
The next edit box shows the location of the 
user's PCOViewers configuration files.  
In the list below the user can choose one or 
more of the config-files found there to be 
started while testing.New configurations may 
be added by the “Add config”-button. Enabling 
one or more configurations will result in TAP-
Caller automatically starting PCO-Viewer(s) 
during test execution. 
The default configuration can be set via the 

“Set default”-button and is used e.g. if the user selects “View PCO logfile” from the context-menu (see 
2.3.2). If "Log with PCO while testing" is set, TAPCaller tells PCO to create a log file of the test session 
for each test case.  

2.5.1.3 Settings – More Viewing Tools 

In this dialog box the user is able to configure options needed 
for viewing test results and debugging. The first edit box 
("Debug Text Viewer") specifies a text file viewer, which is 
started when the user wants to have a look at the results of a 
test case (default: notepad).  

 

In the next edit box the user can enter the location 
of the TDS Flow Viewer "MSCView". The latest 
MSCView executable is in "<view>\Gpf\Bin\". 
MSCVIEW is a tool used to display the expected 
structure of the flow of messages/primitives. 
 
The last edit box is used to specify the location of 
the test definition scripts (*.tds). The user cannot 
load titles, find the final tests or start MSCView 
unless he/she has entered this location. 
This setting is not needed for TDC test cases 
anymore. 
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2.5.2 The Dialog Box "Selection" 

Using the menu "<Configuration><Selection>" the user can access the selection dialog. There he/she 
marks the test cases he/she wants to run and specifies the PS to be tested.  

 
There are two sources of 
test cases at the moment: 
normal test case dlls and 
test document dlls, which 
contain all test cases of a 
test document. TDC test 
cases are also compiled into 
one big DLL. 
In order to help the user 
selecting executable test 
cases TAPCaller distin-
guishes two kinds of dlls: 
test case dlls (dlls which 
match a certain name pat-
tern) and other dlls which 
are possibly test document 
dlls. Test case dlls can be 
selected by clicking the 
check boxes at the left edge 
of the list box. Other dlls 
cannot be selected, but the 
"Details" button is enabled 
for these dlls. Clicking it (or 
just double clicking the DLL) 
results in listing all exported 
functions, who match the 
name pattern of test cases. 
The user can select these 
functions like normal test 
case dlls. If TAPCaller finds 
a dll with the same name as 
a function from a test docu-
ment dll in the same direc-

tory, this function cannot be selected, since TAP searches for a DLL first and opens a test document 
dll when it does not find a test case dll.  
 
Additionally, suites as a possibility of combining test cases with certain commands (for repetition, ran-
dom choice, …) are now available. The suite files contain several internal suites, which are used in 
other suites, and external suites, which are executable by TAP from the command line or via  TAP-
Caller. As for test document dlls the "Details" button is enabled when a suite file is chosen. After click-
ing this button the external suites are added to the selection dialog and can be chosen.  
In order to help the user distinguishing the several file types the second column of the list box contains 
the supposed kind of the file (e.g. "test case dll"). If a test document dll is opened the name of the test 
document is added to the test case functions (e.g. "MCOMP020  from MCOMP"). 
 
The second section of this dialog is for selecting the PS to be tested. The user can let Tapcaller start 
the protocol stack automatically a certain amount of ms before the execution of TAP by selecting the 
executable, checking the “Enabled”-box and specifying the milliseconds. (This is not necessary with 
the newest tap/frame anymore, since automatic synchronization is done). 
If “Enabled” is not selected TAPCaller expects that the PS is already running.  
Selecting “Restart after each testcase” will do exactly what it says ;-) 
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2.5.3 The Dialog Box "Protocol"  

The protocol support of TAPCaller is currently very rudimentary and will be improved in upcoming 
versions. 

In this dialog the user can specify his 
name and a title for the report to be cre-
ated. 
Enabling “Save titles in the protocol file” 
tells TAPCaller to include all test case 
titles in the exported files. 
 
Via the two “Save as ..”-buttons the actual 
report can now be exported. 
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3 Known problems and future tasks 

This paragraph is meant to show which bugs are already found (but not removed yet) and to provide 
an impression of future plans concerning this product. 

3.1 Known bugs 

•  

3.2 „Soon implemented“ 

• Online-Help-update 

3.3 „Nice to have “ 

•   
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Appendices 

A. Acronyms 

DS-WCDMA Direct Sequence/Spread Wideband Code Division Multiple Access 

 

B. Glossary 

International Mobile 
Telecommunication 2000 
(IMT-2000/ITU-2000) 

Formerly referred to as FPLMTS (Future Public Land-Mobile Telephone 
System), this is the ITU's specification/family of standards for 3G. This 
initiative provides a global infrastructure through both satellite and terres-
trial systems, for fixed and mobile phone users. The family of standards 
is a framework comprising a mix/blend of systems providing global roam-
ing. <URL: http://www.imt-2000.org/> 

 


